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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:

1. Provide a Superior Customer Experience
• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.

4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.

7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

About this Guide
• Ross Part Number: 7900DR-004-03
• Release Date: February 12, 2026. Printed in Canada.
• Software Issue: 15.0

The information contained in this Guide is subject to change without notice or obligation.



Copyright
© 2014 - 2026 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross 
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and 
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior 
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross 
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting 
from the use of the information contained herein.

Patents
Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 
7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its Media I/O Server systems to be free from defects under normal use and 
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Media I/O 
Server system, contact your regional sales manager.

Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.



If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.

Use of Hazardous Substances in Electrical and Electronic 
Products (China RoHS)
Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
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Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613.652.4886
Fax: (+1) 613.652.4425

Technical Support: (+1) 613.652.4886
After Hours Emergency: (+1) 613.349.0006

Email (Technical Support): techsupport@rossvideo.com
Email (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com




Media I/O User Guide (v15.0) Contents • i

Contents
Introduction 1

A Word of Thanks ................................................................................................................................................1-1
About This Guide ..................................................................................................................................................1-2
Documentation Conventions .................................................................................................................................1-2

Interface Elements ..............................................................................................................................................1-2
User Entered Text ..............................................................................................................................................1-2
Referenced Guides .............................................................................................................................................1-2
Menu Sequences .................................................................................................................................................1-2
Important Instructions ........................................................................................................................................1-2

Getting Help ..........................................................................................................................................................1-3
Contacting Technical Support ............................................................................................................................1-3

System Requirements 2
Hardware ...............................................................................................................................................................2-2
Software ................................................................................................................................................................2-2

Software Installation 3
Before a Software Install ......................................................................................................................................3-2
Installing Media I/O Database Software ...............................................................................................................3-3
Installing Media I/O Software Suite .....................................................................................................................3-7

Media I/O Server Software ................................................................................................................................3-7
Media I/O Web User Interface Software ...........................................................................................................3-8
Next Steps ..........................................................................................................................................................3-9

Software Upgrades 4
Before a Software Upgrade ...................................................................................................................................4-1



0–ii • Media I/O User Guide (v15.0)



Media I/O User Guide (v15.0) Introduction • 1–1

Introduction
A Word of Thanks
Thank you for choosing Ross Video Media I/O as your video playout solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Media I/O video playout solution from Ross Video. We are confident of 
your future pleasure with your choice.

Yours Sincerely,

Shawn Snider
Vice President of Production Workflow Services
shawn.snider@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide
This guide contains the following chapters that cover the installation and configuration of Media I/O software:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “System Requirements” provides the recommended minimum hardware and software requirements 
to ensure that the Media I/O software functions correctly.

• Chapter 3, “Software Installation” provides instructions on how to install the Media I/O software on a computer 
after a system re-image.

• Chapter 4, “Software Licensing” provides instructions for licensing Media I/O software.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Media I/O User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

When the Media I/O Client cannot connect to the network, a Message dialog box opens to report the connection 
problem.
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Getting Help
The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents
• Index — keyword reference
• Search — full text search
• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files as part of your installation package.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

• Our telephone number is: +44 (0)1189502446
• International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

• Our telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a 
support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com/support/tech-support.html
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System Requirements
Ross Video base Media I/O products on mainstream PC hardware that use the Microsoft® Windows® operating 
system. To ensure that the Media I/O functions correctly, verify that the computer selected to run Media I/O 
software meets the recommended requirements described in the following sections:

• Hardware
• Software
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Hardware
Ross Video recommends the following minimum computer hardware configuration to run Media I/O software:

• Windows Server Hardware (Up to 1 UHD or 4 HD)
› OS — Windows Server 2019 (64-bit) | Windows Server 2022 (64-bit)
› CPU — Dual Intel Silver 4314 2.4GHz, 16C/32T CPU
› Hard Drive — 2x480GB SSD SATA 6Gbps 512e 2.5in Hot-plug Drive
› RAM —64 GB

• Windows Server Hardware (Up to 2 UHD or 8 HD)
› OS — Windows Server 2019 (64-bit) | Windows Server 2022 (64-bit)
› CPU — Dual Intel Xeon Gold 5320 2.2GHz, 26C/52T CPU
› Hard Drive — 2x480GB SSD SATA 6Gbps 512e 2.5in Hot-plug Drive
› RAM — 64 GB

• Server Hardware for Management and Control
› OS — Windows Server 2019 (64-bit) | Windows Server 2022 (64-bit)
› CPU — Intel Core i5-8600, 6 Core, 9MB Cache, 3.1GHz, 4.3Ghz CPU
› Hard Drive — 512GB SATA Class 20 SSD
› RAM — 16 GB

• macOS Server Hardware (Up to 3 UHD or 8 HD)
› OS — macOS 10.11
› CPU — Mac Pro 2.6 Ghz 24-Core Intel Xeon
› Hard Drive — 512 GB
› RAM — 128 GB

Software
Ross Video recommends the following minimum computer software configuration to run Media I/O software:

• Media I/O Server
› Microsoft® Windows® Server 2022 64-bit English only with latest patches
› Microsoft® Windows® Server 2019 64-bit English only with latest patches
› macOS Catalina v10.15.7

• Media I/O Client
› Microsoft® Windows® 11
› macOS Sonoma v14.3

 Visit the Media I/O Release Notes for the latest certification information and for special upgrade notices.
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Software Installation
This chapter provides instructions for installing Media I/O software on a Media I/O computer after a system 
re-image.

The following topics are discussed in this chapter:

• Before a Software Install
• Installing Media I/O Database Software
• Installing Media I/O Software Suite
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Before a Software Install
Before you install Media I/O software on a Media I/O computer, perform the following tasks:

• Have a qualified Ross Video technician perform any required maintenance or repairs on the Media I/O computer.
• Exit all other Windows® programs currently running on the Media I/O computer.
• Temporarily disable anti-virus software running on the Media I/O computer. Some heuristic-based intrusion 

detection systems prevent the installation of Media I/O software. Re-enable anti-virus software after installing 
the Media I/O software.

Contact a Ross Video sales representative for information about Media I/O commissioning, training, and update 
services.

 After installing Media I/O software, you must obtain Media I/O feature licenses from Ross Video Technical 
Support before users can access Media I/O features.

For More Information on...
• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 

page 1–3.

To prepare the Media I/O Management Computer

 IMPORTANT: Before performing an update ensure that you create a full backup your existing customer 
configuration and any associated customer data.

1. On the Media I/O computer, exit all currently running applications.

2. Temporarily disable anti-virus software running on the Media I/O computer.

Some heuristic-based intrusion detection systems prevent the installation of Media I/O software.

3. Navigate to the provided Media IO Installer folder provided by a Ross Video and move it to your Desktop.

4. Ensure that you have the following Media I/O installers:

› Ross Video-Media IO Server-15.0
› Media IO-15.0
› mariadb-11.4.4-winx64

5. Ensure that the following additional software is available:

• Supported Web Browser:
› Chrome v138+

• Microsoft Software:
› NDI5 Tools
› Microsoft Visual C++ Updates

• Board and Drivers:
› Matrox and AJA Video Drivers

 TIP
If required, contact Technical Support to obtain the following software installers.
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Installing Media I/O Database Software

Media I/O uses the MariaDB database to store and manage application data. Only the initial installation or recovery 
installations of Media I/O Server software on the management computer require the installation of the MariaDB 
database software. 

To install the database for Media I/O

1. On the Media I/O Server computer, exit all currently running Windows® applications.

2. Navigate to the provided Media I/O software application files.

3. On the Desktop, double-click on the mariadb-11.4.4-winx64.msi icon.

The Setup wizard opens.

4. Click Next.

The End-User Agreement dialog box opens.

5. Read the GNU GENERAL PUBLIC LICENSE.

6. Select the I accept the terms of the license agreement checkbox.

7. Click Next.
The Custom Setup screen opens.

8. Click Next.
The Default instance properties screen opens.

 INFO
If you are upgrading from an earlier version of Media I/O, please perform the prerequisites steps in the 
“Software Upgrades” chapter.
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9. Select the Modify password for database user ‘root’ checkbox.

10. In the Password box, enter a password that meets the password security requirements set by your organization. 
Record the entered password to replace the password mariadb with your password when installing, 
reinstalling, or upgrading Quorum Server software.

11. In the Confirm box, enter the same password as entered in the Password box.

12. Record the root user password in a safe place.

13. Select the Enable access from remote machines for ‘root’ user check box.

14. Click Next.
The second default instance properties dialog opens.

15. Click Next.
The Ready to Install screen opens.

16. Click Install.
The Installing MariaDB 11.4 (x64) screen opens. A progress bar displays the installation status. After the 
installer finishes installing the required files, the Completed the MariaDB 11.4 (x64) Setup Wizard screen 
opens.

When the Setup wizard cannot start the MariaDB service, it displays the following alert:
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Follow these steps to continue the MariaDB installation:

a. From the Windows Desktop, press Windows Key R.
The Run dialog box opens.

b. In the Open box, type the following application name:
services.msc

c. Click OK.
The Services window opens.

d. In the Services list, locate the MariaDB service.

e. Right-click the MariaDB server and select Properties from the shortcut menu.
The MariaDB dialog box opens.

f. Click the Log On tab.
The Log On tab opens.

g. Select the Local System Account option.

h. Click OK.
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The MariaDB dialog box closes.

i. In the Services window, click Restart for the MariaDB service.

j. Use the File menu to select Exit.

The Services window closes.

k. In the open alert, click Retry.

17. Click Finish.

The Setup wizard closes.
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Installing Media I/O Software Suite
After you install each of the applications below, the Media I/O software will be automatically set up in the default 
directory folders. Make sure to install each of the Media I/O installers in the order listed below.

 PREREQUISITES: 
You must install and configure MariaDB database software on the Media I/O Server computer before installing 
the Media I/O software suite below.

• “Media I/O Server Software”
• “Media I/O Web User Interface Software”

Media I/O Server Software
To install Media I/O Server Software

1. To run the Transcode Installer Wizard, double-click on the Ross Video-Media IO Server-15.0 installer:

2. Click Next.

3. Click Next.

4. Click Next.
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5. After installation of the Media I/O Server is complete, click Finish.

Media I/O Web User Interface Software
This will show you how to install the Media I/O user interface that opens in a supported web browser.

To install Media I/O Software

1. Navigate to the Media I/O Installer folder.

2. To run the Media I/O web-based user interface, double-click on the installer, Media IO-15.0.

3. Click Next.

4. Click Next.

5. Click the Ross Media I/O icon.

6. Click the Install button.



Media I/O User Guide (v15.0) Software Installation • 3–9

7. Click the Finish button.

Next Steps

 INFO
After installing Media I/O software, you must obtain Media I/O feature licenses from Ross Video Technical 
Support before users can access Media I/O features.
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Software Upgrades
This chapter provides instructions for upgrading the Media I/O software on your computer to the latest version of 
the Media I/O software.

The following topics are discussed in this chapter:

• Before a Software UpgradeIMPORTANT: If you are upgrading from a previous version of Media I/O you must 
follow our Application Note detailing how to use our Media I/O upgrade tool to migrate from v15.13 and later to 
Media I/O v15.0. Please see: Media I/O v15 Software Upgrade Instructions.

Before a Software Upgrade
 IMPORTANT: If you are upgrading from a previous version of Media I/O you must follow our Application 

Note detailing how to use our Media I/O upgrade tool to migrate from v15.13 and later to Media I/O v15.0. 
Please see: Media I/O v15 Software Upgrade Instructions. 
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